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Abstract 

Corporate training is essential for employee upskilling and reskilling. Companies invest huge amounts in the 
development of training pathways. It has a direct impact on employee productivity and efficiency. Many organizations 
have a set of mandatory compliance-related training for new employees to avoid compliance issues. Tracking this 
training status is a tedious task. The Human Resource Learning & Development team makes available many courses 
for employee upskilling and reskilling but whether the employees are using these training for their upskilling is a 
challenging task to track. Organizations also like to know many insights like - How much progress the employee has 
made on assigned training? What portion of total employees have completed the particular section of assigned 
training? Etc. In this situation, soft automation using modern Microsoft tools, mainly Power Query and Power 
Automate are useful tools that simplify the problem. In this paper, it is demonstrated that the use of automation 
techniques using these tools can help to track corporate training and improve the training completion rate of the 
employees thereby creating good opportunities for their growth. This automaton will also save an enormous amount 
of time as compared to manual tracking. This research paper is applicable to all sectors since training is part of all 
corporate learning programs. Corporate companies can leverage this automated training tracking mechanism to upskill 
their employees. 
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1. Introduction
In the modern era of globalization, things change rapidly and continuously. There are frequent and regular updates in 
tools and technology, laws, methods, etc. To withstand these challenges, there is constant need to improve and learn 
the new technologies and concepts (Cukir.W.,2020). The organization creates e-learning pathways to reskill/upskill 
their employees based on their needs. Learning pathway is described as the chosen route taken by a learner through a 
range of (commonly) e-learning activities, which allows them to build knowledge progressively (Jih, 1996), (Iofciu et 
al., 2012). Nowadays, e-trainings are most preferred method by corporate companies due to their agile and scalable 
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nature. The popularity of e-trainings has increased recently due to the Covid 19 pandemic. Pandemic has significantly 
influenced the development of E-training, keeping in mind that traditional training has limits that lessen its 
effectiveness on a global scale in such pandemic situation (WOLOR et al., 2020). Corporate managers are constantly 
looking for better cost-effective ways to deliver training to their employees. E-learning is less expensive than 
traditional classroom instruction and in addition, many expenses like booking training facilities and travel costs for 
trainers are greatly reduced (Strother, 2002). These e-training are the self-learning modules that can be accessed 
anytime and anywhere by the employees. Organizations use many learning platforms like Degreed to create and 
integrate a structured learning pathways (Sotubo, 2019). These structured e-learning pathways are a crucial component 
of the onboarding strategy that aids new hires in acquiring the skills necessary to carry out their duties. 

On these online learning platforms,   completion status reports can be fetched for each training pathways for 
employees who have completed modules inside those pathways at the time the completion status report is 
requested/generated.  

1.1 Objectives 
The objective of this work is to meet onboarding and talent development needs at a global scale by tracking the 
onboarding completions with minimum efforts. The attempt has been made to uniform onboarding across regions and 
different offices and to track onboarding completions. Uniform onboarding and talent development among the newly 
recruited employees lead to project readiness of an employee and thereby reducing the burnout of space teams. The 
reduction in the burnouts/burden on existing employees to teach new employees will drastically save the time and 
improve the productivity. This also reduces the dependency of the new employee on the existing employee. 

Specialized tool has been used to monitor the employee onboarding progress and to remind them about completion of 
training. Allowing employees dedicated training time during the workday will encourage them to complete their 
training (Hansen, 2020). Also, tool seeks management consensus for focused learning time for the employees as it 
will help the employee to be project ready before joining the project team. The timely tracking of the completions will 
keep the learner motivated. The effectiveness and efficiency of the employee will be increased if he/she undergoes 
the onboarding and talent development. 

2. Literature Review
Employers face challenges in recruiting and retaining staff with required skill-sets. These challenges are increasing as 
digitization, automation and artificial intelligence are continuously changing the types of skills employers need. 
McKinsey estimates that 14 percent of the global labor force may need to change jobs as technology transforms the 
nature of work. Many companies are developing ambitious strategies to reskill and upskill their employees 
(Cukir.W.,2020). Learning and development efforts can fall short of their objectives from being overlooked by 
employees or a lack of personal motivation. Digital nudges like push notifications are also effective tools to encourage 
people to take desired learning actions (Sotubo, 2019). 

Measuring results using metrics such as level of engagement among users, number of power users on the site, learning 
completion rates among users, satisfaction rates among users, the correlation between engagement, achievement levels 
and individual promotions and other external career progressions among users can help  improve training objectives 
(Sotubo, 2019). 

Lack of training is one of the factors for attritions. The majority of studies agree that there are a variety of significant 
aspects that influence turnover; one of the most important among them is that one should study new technologies if 
they want to boost employability. Companies should treat training as career growth and offer relevant training to retain 
staff. (Pallathadka et al., 2021).Even during pandemic situations, it is clear that e-training positively and significantly 
affects employee performance (WOLOR et al., 2020). 

Excel is one of the most used BI tool. Users can perform BI in Excel in two ways: by using Vanilla Excel and Power 
tools. Vanilla Excel is the use of Excel without Power tools such as Power Query and Power Pivot. To empower Excel 
as BI tool, power tools such as Power Query and PowerPivot were introduced in recent versions of Excel (e.g. Excel 
2016, 2019) making Excel compatible to handle multiple sources and large volumes of data as compared to Vanilla 
Excel (Leonard et al., 2021).  
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Power Query is an ETL application. ETL is an acronym that stands for extract, transform, and load. It links and extracts 
data from numerous external sources, including CSV, folders of files, PDFs, web pages, SharePoint, etc. with ease. 
With the click of a button (Figure 1), this connection is refreshed. Every time you import, there is no need to locate 
the file or provide the URL. The next step is transformation, which involves taking further actions to shape and clean 
the data into something useful and essential. These steps include removing, sorting, filtering, splitting, replacing, and 
loading more transformations. The final step is to load the transformed data for utilization. (Murray, 2021). 
 

 
Figure 1.  Power Query Architecture 

 
Business Process Automation: 
Automating repetitive manual tasks using power automate has saved time for many business processes (Critchley, 
2020). Power Automate comprises mainly two elements: Trigger and Action.  
 
Trigger is the event that launches a flow. Trigger is input to the flow to perform the next preceding action based on 
the trigger condition. The examples of triggers include when an email is received, when a file is created in SharePoint 
and when a message is received on team channel.  
 
Action performs specified work if the earlier defined event (Trigger) occurs. The examples of action are sending an 
email, sending notification and posting a message in the teams channel (Critchley, 2020),(Timus et al., 2020).  
 
Power Automate is a workflow system that provides event-to-action type automation of operations inside and beyond 
the Microsoft 365 family of products, such as Outlook, Teams, SharePoint, etc. It aims to automate repetitive 
operations for individuals and businesses in order to connect apps that would otherwise require development work 
and potentially lengthy periods of time(Critchley, 2020). It also helps to reduce human efforts and increase morale as 
repetitive operations are delegated to automation. 
 
Most of the authors have discussed the importance of training and how training benefits individual employees and the 
organization as a whole. There are no papers that discuss tracking and improving the training completion rate of 
employees.  This paper will discuss the effective E-training tracking mechanism using modern Microsoft Power tools 
and how these tools can also be leveraged to generate business insights and meet our objectives. 
 
3. Methodology 
In this work to create an effective E-training tracking mechanism, application of Microsoft tools viz. Excel Power 
Query, SharePoint and Power Automate have been used. Fetching training completion status for each pathway on an 
e-learning platform like Degreed is the first step to analyze the training progress. These reports act as the input data 
for the final training tracking report and dashboard. The below process flow is followed to generate a report. 
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Figure 2. Flow diagram 
 
Training needs of employees vary depending on multiple factors viz. working experience, educational specializations, 
domain knowledge, level of skills requirements etc. Employee losses due to layoffs, resignations, and early retirements 
are a constant source of concern for management (Figure 2); employee upskilling and reskilling is one element that 
helps to retain employees and reduce employee turnover (Neumann et al., 2002), (Samson, 2013). Upskilling and 
reskilling are essential for maintaining company standards and being competitive in a global environment. This leads 
to develop/use specialized application tools to create an effective E-training tracking mechanism. Application of 
Power query and Power Automate have been used here to carry out effective E-training and tracking.  

The effort is made to generate training summary for each resource by consolidating training completion status reports 
of all pathways using power query and refresh the training summary after getting updated training completions status 
reports for all of these pathways by automating the tasks using power query to reduce time required to consolidate the 
training status. Later, additional effort is taken to nudge employees based on their current learning progress using 
Power Automate to enhance training completions among employees with minimum efforts.  
 
The process flow given in Figure 1 is followed to generate a training tracking report. 
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4. Application of Power Query and Power Automate 
Power Query is a useful tool to extract the raw data from various sources and transform into the analyzable format. 
This tool is easily available in Microsoft excel and easy to use tool. Business users often spend up to 80% of their 
time preparing data, which slows down analysis and decision-making. This issue is exacerbated by a number of 
difficulties, many of which are resolved quickly with the use of Power Query ( Power Query documentation,2022). 

Power Automate is soft automation tool developed by Microsoft. It is by default available with Microsoft office 365 
account. The main purpose of Power automate is to automate day to day business operations by connecting it with 
other application like outlook, teams etc.  

SharePoint is also Microsoft’s platform which is mainly used for storing data in online drives 

Power Query and Power Automate can be leveraged to track the training to achieve organization’s learning objective 
with minimum efforts.  

The process starts with creation of two SharePoint folders viz. Consolidate folder and Dump folder. Consolidate folder 
will have single excel file where all required data transformation using Excel Power Query will be carried out. This 
folder carries the information relating to training competition of all employees in the consolidated forms. This folder 
retrieves each individual's data on overall training completions, module completions, section-wise training 
completions, and so on by extracting and transforming all pathways training completion status reports that were 
downloaded from the online training platform and dumped in the Dump folder. 

 

 

 

 

 

 

Figure 3. SharePoint folders 
 

The representative SharePoint folders is shown in Figure 3.Figure 4. shows the different pathways training reports 
that were downloaded from the online training platform like degreed. 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Figure 4. Pathways training completion report in SharePoint Dump folder 
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The next steps are loading each pathway training completion status reports placed in Dump folder to Power Query, 
transforming it in the required tracking format and loading final output report into the consolidated excel file.  
Connect: Connect pathways training completion reports stored in ‘Dump’ folder to power query editor in the 
Consolidate excel file using below steps 

a. Click on Data > Get Data > From File > From SharePoint Folder
b. Paste your organization SharePoint folder location in the appeared window and authenticate the

connection by signing in using your organizational credentials.
c. Using Filter command, only select folder where training completion status reports of all pathways are

placed. In this case, it is ‘Dump’ folder.
Transform: Based on the input data file structure use different transformational steps in power query, Power Query 
records all these transformations in the forms of steps. A set of applied data transformations steps is called as query. 
If required edits can be made in these steps. 
By creating multiple queries, transform the data fetched from the online learning platform to generate meaningful 
results such as section-wise % completion for each employee, total % completion for each employee etc.  Few 
examples are shown below. 

Figure 5. Query 1  Figure 6. Query 2   Figure 7. Query 3 

Use the Merge query function to bring all individual results in the summary report. Merge query will combine multiple 
columns from different tables into one ( Power Query documentation ,2022). This can be done using common unique 
data columns from different tables. In this case, employee ID can be a unique column to merge queries. (Figure 5-7) 
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Figure 8. Merge query function 

Query Dependency: Query Dependencies in Power Query is helpful for getting a general sense of what is happening 
in a workbook ( Power Query documentation,2022). Check query dependencies by clicking on View > Query 
Dependency. This will give pictorial view of all the relation you have created using merge query function. It also 
depicts the method to arrive to the summary report using multiple queries. Leverage this query dependency view while 
modifying/creating new queries to generate more insights using existing queries. 

Figure 9. Query dependencies 

1825



Proceedings of the 2nd Indian International Conference on Industrial Engineering and Operations Management 
Warangal, Telangana, India, August 16-18, 2022 

© IEOM Society International 

Final Summary Report: This report indicates status of all modules within each learning pathways for each employee. 
1 indicates completed modules and 0 indicates yet to complete modules. Apart from this, this report also includes 
section-wise % total completion for each employee and % total completion of overall training modules. 

Figure 10. Final summary report 

Load: Load Summary Query to Excel workbook, all remaining queries that are used/referenced by summary query to 
generate final summary report should be loaded as connection only. Apart from this summary report, by using similar 
transformational techniques generate organizational insights such as % timely completion, month wise onboarded 
users and their completion status and total completion rate. These performance indicators will help organization to 
know whether set training process is being followed or not and will also help management to take necessary actions 
in case of deviations (Figure 8-10).  

Power Automate to enhance training completion rate for the employees: 
Digital nudges are an excellent method for encouraging people to execute desirable learning behaviors, as mentioned 
in the literature review (Sotubo, 2019). Organizations can use Power Automate as an automation tool to push 
employees through email reminders and persuade them to engage in required training. By connecting Microsoft Power 
Automate to an Excel report created with Power Query and your organization's Outlook account, design a process 
flow in Power Automate that, with just one click, will send an automatic email to all assigned trainees outlining their 
individual percent completion rates and leftover modules/sections. Another strategy to enhance individual training 
completion rates is to include the appropriate reporting manager in the same email and request their approval for some 
dedicated learning time for the employee (Figure 11). 
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Figure 11. Power Automate process flow diagram 
 
 
Power Automate Actual flow: Figure 12 shows flow developed using the Power Automate to nudge the colleagues. 
The use of Power Automate aims to achieve our learning enhancement goal by automating time-consuming 
repetitive activities for organizations to trigger learning reminders at regular intervals that would take potentially 
extended periods of time if handled manually using human resources. 
 
 

 
 

Figure 12. Power Automate flow 
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5. Results and Discussion
The final training summary report prepared using Excel Power Query can be updated with only one click (Power 
Query documentation, 2022). To update the training summary, just swap out the outdated completion reports for each 
pathway in the Dump folder with the most recent reports available from the online learning platform at the time of 
refresh. Power query will perform all back-end activities and load the finished report into Excel in a matter of minutes. 
Summary report can also be prepared using vanilla excel. i.e. using conventional excel formulae. But creating it using 
plain excel formula has a major drawback that for every refresh we need to put manual efforts to create similar 
summary report which we created using power query. This would take minimum 2-3 hours depending upon the 
number of data files (in this case it will be number of pathways) we are collating. Apart from this, there are chances 
of errors since manual report creation requires attention to detail every time one creates a report. Similarly, manually 
nudging employees for training completions take significant amount of time. Using Power Automate, nudge can be 
sent to large number of employees within fraction of seconds. Since, these are the scheduled reminders from Power 
Automate, there will be no delay and no chances of missing reminder for any employee. The below table 1 summarizes 
the approximate time saved using conventional and proposed tracking mechanism. 

Table 1. Summary of Time saving using suggested method 

From the results, it is found that using Excel Power Query, the % time saved is by 87.5% for refreshing training 
reports. Additionally, the % time saved is by 94.4% to send nudge notifications to employees for training completion 
using Power Automate. 

From the research work, it is observed that the methodology adopted could improve the learning completion rates of 
the employees and moreover it enhanced the overall efficiency and effectiveness of the organization. 

6. Conclusion
The most important asset of any organization are the employees. Learning and development of the employees is 
directly related to the retention of employees in the organization. Therefore, tracking the training of employees is 
becoming critical task. By application of Power Automate and Power Query, completion and progress tracking has 
become manageable. Moreover, the extra efforts of senior employees are saved if the trainings are given to the junior 
employees by e-learning portals. This improves the overall efficiency and effectiveness of all the employees working 
in the organization. The time is saved and efforts are aligned on other significant activities. To conclude, effective e-
learning has become mandatory for organizations in global environment of businesses and project management 
technique of tracking the completion and progress of learning of employees will help the organizations increase the 
chance of success in their future endeavors. 
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